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PREFACE

In recent years, digital image technology has made wide format
scanners an affordable solution for many graphics businesses. In fact,
wide format scanners as input devices offer so many advantages that
they are hard to overlook. Usage of  Adobe Photoshop on Apple
Macintosh or Windows platforms is widespread among graphics
professionals and this software is designed to supply convenient,
direct and problem-free access to Wide Format Scanning input while
working with Adobe Photoshop.

This software is designed as a PLUG-IN, meaning it can just be
inserted into Adobe Photoshop’s plug-in folder and immediately
accessed through the Photoshop interface.

The Plug-in can be obtained in a Macintosh version or a Windows
version. For Macintosh users, this software is a necessary link
between a Wide Format Scanner and an Apple Macintosh platform
with a built in SCSI board, because the standard scanning software
normally supplied with your Wide Format scanner is designed for
Windows. For Windows users, the software is a handy scanning
interface specifically useful when working in Adobe Photoshop.

Screen illustrations in this user guide display the Macintosh user
interface. Dialog structures, options and functionality are identical in
both the Macintosh and Windows versions and this user guide applies
for both.

SYSTEM REQUIREMENTS
• Apple Macintosh Power PC computer and operating system or IBM

PC and Windows operating system. see Chapter 2: "Installation" for
more details.

• Supported Contex Full Scale Scanner. See the attached
README.TXT file for updates on the exact scanner models that
run with this software.

• Adobe Photoshop, version 5.0 or higher.
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RELATED PUBLICATIONS

The "OPERATIONS GUIDE" which came with your computer.

The "OPERATORS GUIDE" which came with your Full Scale Scanner.

User Guide and other documentation that came with your Adobe
Photoshop Software

See the README.TXT file on the distribution CD for latest information
and news.

How To Use This Guide

This guide contains 5 chapters and 3 appendices. Make sure you read
chapter 2: Installation, and that the scanner is installed on the SCSI
interface port, before attempting to install or use the software
described in this guide.

Chapter 1. An introduction to the Plug-in’s features.

Chapter 2. Describes how to install the Plug-in.

Chapter 3. Overview of the application interface, and general
instructions on Wide Format Scanning with the Plug-in

Chapter 4. Describes the scanning options in detail.

Chapter 5. Troubleshooting - Answers to Common problems.

Appendix A. Contains a glossary

Appendix B. Application License Agreement.

Appendix C. Index.
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Document Conventions

The following typographical conventions are used throughout this user
guide:

• Dialog, button, selection and option labels are capitalized as they
appear in the application and written in Italics for enhancement.
Examples: Select Scan.

• Names of application components appear in italics, conventional
book title capitalization  format (proceeding caps in each word).
Examples : The  Scan Control Dialog.

• Terms that are not tools but internal definitions related to the
application’s features will appear without italics but in conventional
book title capitalization format.
Examples: Scan Window
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1. Introduction
This is an application designed to interface your Full Scale Scanner
with advanced graphics software on an Apple Macintosh or Windows-
based platform. The application is developed for usage with Adobe
Photoshop – the leading image software among  graphics
professionals.

The software is designed as a plug-in, meaning it is a full software
program that extends the functionality of the Adobe Photoshop
program by enabling access to Wide format scanning. Install the
program into Adobe Photoshop’s plug-in folder and it immediately
becomes accessible through Photoshop. You select the application
through Photoshop’s File menu and thereby gain full control over
advanced scanning features.

In Photoshop terms, this is an import plug-in meaning it imports
images from the scanner into the Photoshop image editor. You can
then use Photoshop’s wide range of image manipulation options, just
as if you had opened an image file from your hard disk.

Here are some of the main features obtainable through this
application:

• Easy scanning directly into the Adobe Photoshop interface without
leaving Photoshop.

• Convenient dialogs with full point and click control.

• Standardized paper size options fitted to popular input media sizes.

• Custom paper size options, enabling full control over non-standard
input media sizes.

• Offsetting – Selecting specific areas on the original for scanning.

• Advanced tonal adjustment features at scan time through Gamma
Curve setting.

• Easy adjustment of Brightness, Contrast and Blur.

• A wide range of scanning modes enabling you to obtain optimal
quality or even improve quality in relation to your original.

• Full 24-bit color mode with scan-time color enhancement options.

• High quality monochrome scanning through selectable modes
designed for different original types and needs.
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• Advanced 2-D Adaptive thresholding that analyses the drawing
while scanning, and varies the threshold to compensate for
changes in background, faded areas and stains.

Fig. 1-1: Plug-in system – Wide Format Scan to Photoshop

SCSI I/F

Scan directly into Photoshop

 Wide Format Scanner
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2. Installation
The plug-in requires a Full Scale Scanner correctly installed and
powered on, in order to function. See the documentation that came
with your scanner for scanner installation instructions.

Always check the README.TXT file for updates describing installation
procedures. The README.TXT file will also list scanner models
compatible with this plug-in.

It is recommended to read Adobe Photoshop’s documentation
regarding Plug-in applications and their installation.

2.1 Install the plug-in on Macintosh PowerPC

System Requirements:
The README.TXT file contains instructions and tips for optimizing
your scanning performance and Photoshop
system.
• Apple Macintosh PowerPC.
• Minimum 128 Mb. RAM
• Hard Disk with room for wide format image data. For example, an

A4 sized image document, scanned in color at 300 dpi will use
about 30 MB on your hard disk.

• Adobe Photoshop 5.0 installed

Installation
The plug-in executable WideFormatScanning.8ba must be inserted
into Adobe Photoshop’s Plug-in directory. Here’s how:

⇒ Uncompress the file WFS.sit.
⇒ Save the README.TXT file in a folder of your choice.
⇒ Copy the file WideFormatScanning.8ba into the folder :

Macintosh HD: Adobe Photoshop 5.0:Plug-Ins:Import-Export

⇒ Control your installation
⇒ If Adobe Photoshop was running when you inserted the plug-in,

then exit Photoshop.
⇒ Start (or restart) the Adobe Photoshop application.
⇒ Select File > Import
⇒ You should have a new option in the import group called:

“Wide Format Scanning”
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2.2 Install the plug-in on Windows 95, 98, NT

System Requirements:
• IBM PC or compatible with Windows operating system.
• Minimum 128 Mb. RAM
• Hard Disk with room for wide format image data. For example, an

A4 sized image document, scanned in color at 300 dpi will use
about 30 MB on your hard disk.

• Adobe Photoshop 5.0 installed

Installation
The plug-in executable WideFormatScanning.8ba must be inserted
into Adobe Photoshop’s Plug-in directory. Here’s how:

⇒ Uncompress the file WFS.zip
⇒ Save the README.TXT file in a folder of your choice.
⇒ Copy the file WideFormatScanning.8ba  into the folder :
C:\ProgramFiles\Adobe\Adobe Photoshop 5.0\Plug-Ins\Import-Export

Where “C” is the drive in which your Adobe Photoshop 5.0 is installed.

Control your installation
⇒ If Adobe Photoshop was running when you inserted the plug-in,

then exit Photoshop.
⇒ Start (or restart) the Adobe Photoshop application.
⇒ Select File > Import
⇒ You should have a new option in the import group called:

“Wide Format Scanning”
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3. Getting Started

3.1 Starting the application from Photoshop

This wide format scanning application is constructed as a plug-in to
Adobe Photoshop, and must be accessed through the Photoshop user
interface. In Adobe Photoshop terms, wide format scanning is an
“Import” action in which the scanner imports images into the
Photoshop editor. Once in the editor, the image can be manipulated as
if it were opened from the hard disk. Follow the following steps to start
the Wide Format Scanning plug-in.

⇒ Start the Adobe Photoshop application
⇒ Select File -> Import
⇒ From the list of import sources, select Wide Format Scanning as

shown in Figure 3-1 below.
⇒ The Wide Format Scanning interface is shown in Figure 3-2.

Fig. 3-1: Start the Wide Format Scanning Plug-in in Photoshop
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3.2  An overview of the Plug-in user interface

The Wide Format Scanning dialog can be divided vertically into two
logical option areas.

On the dialog’s left side you find the main options, i.e., those related to
the scanning settings including image quality parameters and control
(start/end) buttons. The Adjustments option group area contains
options related to the current scanning Mode selected in the topmost
option box. Therefore, the available Adjustment options and the
appearance of the Adjustment group area changes with your selection
of scanning Mode. In the above figure, the adjustment options for the
RGB (color) mode are displayed.

The right side of the dialog contains central preference settings, i.e.,
your choice of measurement units and your choice of how the original

Scanning Settings                                                      Preferences Settings

Control buttons            Adjustments group

Fig. 3-2: Wide Format Scanning Interface
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is going to be inserted into the scanner.  Your current paper size
settings are displayed below the unit option area, using the
measurement units you selected just above.

3.3 Scan into Photoshop – Basic Steps

The following is a quick overview of the minimum you must perform to
scan an image into Photoshop. In the next chapter “Scanning Options
and Features”, we will look at each of these steps in greater detail,
focusing on the available possibilities for achieving the best scan
quality for your current original. For now, let’s just see how the plug-in
works:

⇒ Your computer needs to register the scanner at startup. Make sure
the scanner was turned on when you started your computer. If not,
turn the scanner on and then restart/reboot the computer.

⇒ In the remainder of basic steps, it is assumed that you have
installed the Wide Format Scanning plug-in as described in
Chapter 2. If not, please do so before proceeding.

⇒ Start the Adobe Photoshop application.

⇒ In the Adobe Photoshop interface, select File > Import.

⇒ Select the “Wide Format Scanning” import device

⇒ The Wide Format Scanning interface pops up

⇒ Set your scanning Mode. Here you must decide if you wish to
perform color, graytone of B/W scanning. With B/W scanning, you
can select from different automatic image enhancement modes.
Scanning modes, together with their specific characteristics and
usefulness, will be described in the next chapter.

⇒ Set your scan Resolution, i.e., the image resolution in the resulting
Photoshop image. You can select one of the common resolutions
or else specify your own resolution. Tips on choosing the best
resolution for your specific job will be given in the next chapter.

⇒ Set the Paper Size of your original drawing. The scanner needs
this information to determine the size of the area you want
captured. It would be uneconomical to scan too much background
by over estimating original dimensions and undesirable to scan
only a portion of the image you wish captured. You can select
commonly used standard sizes or you can customize new sizes for
special originals. You can also pick out a limited area for scanning
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using Offsets, Width and Height settings. These features will be
described in the next chapter.

⇒ Select your insertion method in the Paper Load option group area.
Central loading is recommended for most sizes and guide marks
for many standard sizes are printed near the scanner insertion slot
at the center loading point. Make sure your setting complies with
the actual insertion position of the original (side or center).

⇒ Adjust your scanning mode through its specific adjustment
parameters. In Figure 3-2, the adjustment parameters for the RGB
(color) mode are shown. Brightness, Contrast, Gamma values and
a color Blur filter  can be set/adjusted with the RGB mode. Other
parameters apply for BW and Adaptive modes. Mode and tonal
adjustments are described in detail in the next chapter.

⇒ When you have made all your settings, select the Scan button on
the dialog’s lower left side.

⇒ Check the image input by the scanner. If you are satisfied with
your results, i.e., image size, adjustments, etc., then select the
Done button. This action will remove the Wide Format Scanning
dialog and return all control to Photoshop’s editor with the scanned
image loaded.

⇒ If you are not satisfied and wish to repeat the scan, make the
revised adjustments and select the Scan button. Repeated
scanned images will be opened in new Adobe Photoshop edit
windows, or as long as the Wide Format Scanning interface
remains active. This enables you to re-scan an original with
different settings, compare the results at the end and then choose
the best one for further editing in Photoshop.

⇒ The <ESC> key can be used at any time to back-step and finally
abort the Wide Format Scanning dialog. Hitting <ESC> will also
interrupt an ongoing scanning process.



Setting Scanning Options 4-1

4. Setting Scanning Options and Features
In the last chapter, we covered the steps necessary to scan into the
Photoshop editor. You probably recall, that the bulk of the steps
mentioned involve setting options relevant to your scanning task and
your current original. In this chapter, we will look at each option
separately and describe how best to use them. The options described
here control your scanner’s built-in enhancement features and if you
use them optimally, they can make a big difference to your end result.

4.1  Scanning Modes and Adjustments

The scanning mode is your central option. This is where you evaluate
the kind of original you are scanning and determine the kind of image
you wish produced. Some of the available scanning modes can be
used to enhance the quality of unclear and low contrast originals. With
the adaptive modes, the scanner makes scan-time assessments of
your drawing using 2-Dimensional Adaptive Thresholding in which
graytone information on each pixel is stored and compared with its
neighboring pixels in order to rebuild a high image quality. The color
and graytone modes are for reproducing images with all the
colors/tones intact.
Each scanning mode has its own set of adjustments options. Only
adjustments relevant to your selected scanning mode will be displayed
in the dialog’s adjustment area. Adjustment options relevant to the

Fig. 4-1: Scan Mode Selection
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scanning Mode appear immediately in the Adjustments area when you
select or change your scanning Mode.
Each scanning Mode, its characteristics, typical usage, and
adjustment options are described in the next sections. Use these
descriptions to find and adjust the scanning Mode that best suites your
particular original or scanning task.

4.1.1 Scanning in B/W Threshold Mode
This mode uses a threshold to determine whether a pixel is black or
white. Use this mode for drawings and line art. You set the threshold
value in the Adjustments area.

Setting the Threshold
When a camera in the scanner looks at a drawing, it converts what it
sees to graytone levels between 0 and 255 with the dark tones
represented by low values and the light tones by high values and
middle tones by middle values. When  scanning at a specific threshold
all gray tones below the selected threshold value will be represented
as black pixels, and all gray tones above will be represented as white
pixels.
For example, if you have a very faded line drawing, you might want to
increase clarity by setting a high threshold, thus forcing more shades
of gray to black. In other words: the higher the threshold, the darker
the result.
The Threshold value, ranging from 0 to 255, can be set in the
Adjustments – Threshold edit field.

⇒ Set the threshold value in the Adjustments area edit field using the
guidelines above.

⇒ Evaluate your setting in the resulting image loaded in the
Photoshop window.

⇒ If the image is too dark, repeat the process with a lower threshold
and if you wish it darker, try a higher threshold
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4.1.2 Scanning in B/W Adaptive Mode
In this mode the threshold adapts to darker or lighter areas in the
original as opposed to the B/W threshold mode that uses a singular
global threshold. The BW Adaptive mode is  suitable for scanning all
kinds of line drawings including difficult blueprints, brown
transparencies (sepias), etc. A stained or faded original can be
renewed as good sections are retained and bad ones clarified. This
mode provides minimum file sizes and is, thereby, well suited for
digitizing. The BW Adaptive mode uses the scanner’s 2D Adaptive
technology.

Setting the adaptive Level
Adaptive Level works like a threshold - the lower the value, the more
of the background is picked up during scanning. You set the adaptive
Level in the Adjustments area.

Fig. 4-2: Drawing Scanned at
threshold setting of 45.

Fig. 4-3: Same drawing at threshold
setting of 210

  
Fig. 4-4: 2D - Adaptive Scan – Before(original)  and After(scanned image)
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4.1.3 Scanning in B/W  Adaptive Gray Mode
Thresholding works like the B/W Adaptive mode but toned shades of
gray are added to enhance image quality. The toned shades of gray
are added in regions between black and white levels using the
scanner’s built-in ADL (Area Diffusion Logic). This mode is suitable for
displaying or printing files scanned from light to medium dark
drawings. The added grays provide a pleasing result for drawing
printouts. Uses the scanner’s 2D Adaptive technology.

Setting the adaptive Level
You set the adaptive Level in the Adjustments area. Adaptive Level
works like a threshold - the lower the value, the more of the
background is picked up during scanning.

4.1.4 Scanning in B/W Adaptive Photo Mode
This is a 2D-Adaptive halftone mode suitable for photos and printouts
of photos. Halftones are distributed throughout the image using the
scanner’s built-in ADL (Area Diffusion Logic) for softer transitions
between black and white. The overall half-toning provides a good
result with photos.

Setting the adaptive Level
You set the adaptive Level in the Adjustments area. Adaptive Level
works like a threshold - the lower the value, the more of the
background is picked up during scanning.

4.1.5 Scanning in Graytone Mode
In this mode 256 gray levels are recognized for each pixel (1 byte, 8
bits per pixel). Gives good reproduction of complicated B/W images
like B/W photos. You adjust Contrast, Brightness, Gamma and Blur in
the Adjustments area.

Graytone Mode adjustments

• Brightness
Use brightness to compensate for a light or dark original being
scanned. Numeric values for brightness are defined by clicking on
the up/down arrow buttons or by editing directly in the fields. The
normal position is zero with negative values for reducing
brightness and positive values for intensifying brightness.
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• Contrast
Contrast is the range between light and dark in an image. An
image with little midtone detail, heavy shadows and bright
highlights has too much contrast and, conversely one mainly with
midtone detail, grayish shadows and highlights has to little
contrast. Numeric values for contrast are defined by clicking on
the up/down arrow buttons or by editing directly in the fields. The
normal position is zero with negative values for reducing contrast
and positive values for adding contrast.

• Gamma
Gamma adjustment can be used to make tone distribution lighter
or darker in an image with emphasis on midtones rather than the
extreme (black, white) ends. Turn up the Gamma value to lighten
the image tones and turn down the Gamma value to darken the
tones.

• Blur
The Blur filter blends graytones and thus removes unwanted
“noise” from the image. The value you set determines the degree
of graytone blending.

4.1.6 Scanning in RGB Color Mode
24 bit true color mode for capturing all of the image’s colors.
Distribution of tones can be adjusted in the Adjustments area.

RGB Mode adjustments
As with the Graytone mode, you can adjust Contrast, Brightness,
Gamma and Blur in the Adjustments area, but here, the adjustments
apply to the color tone channels.

• Brightness
Use brightness to compensate for a light or dark original being
scanned. Numeric values for brightness are defined by clicking on
the up/down arrow buttons or by editing directly in the fields. The
normal position is zero with negative values for reducing
brightness and positive values for intensifying brightness.

• Contrast
Contrast is the range between light and dark in an image. An
image with little midtone detail, heavy shadows and bright
highlights can have too much contrast and, conversely one mainly
with midtone detail, dull shadows and highlights can have little
contrast. Adjusting the contrast can make colors more vivid and
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realistic. Numeric values for contrast are defined by clicking on the
up/down arrow buttons or by editing directly in the fields. The
normal position is zero with negative values for reducing contrast
and positive values for adding contrast.

• Gamma
Gamma adjustment can be used to make tone distribution lighter
or darker in an image with emphasis on midtones rather than the
extreme (black, white) ends. All three (Red, Green , Blue) color
channels are effected together with each change. Turn up the
Gamma value to lighten the image tones and turn down the
Gamma value to darken the tones. For example, if you are
scanning a picture of a blue sea,  a lower Gamma value will
change the sea’s color towards a darker marine blue, and turning
up the Gamma value will change the normal sea color to a light
sky-like blue.

• Blur
The Blur filter blends colors and thus removes unwanted “color
noise” from the image. The value you set determines the degree
of color blending.



Setting Scanning Options 4-7

4.1.7 Overview of Scanning Modes*

Mode Usage Adjustments

BW Threshold Drawing and lineart Threshold value

BW Adaptive Line drawings difficult
blueprints, sepias,
faded/stained
drawings.

Adaptive Level

BW Adaptive Gray Copying light to
medium dark
drawings. The added
grays provide a
pleasing result for
drawing printouts.

Adaptive Level

BW Adaptive Photo Photos and printouts
of photos.

Adaptive Level

Graytone Monochrome image
reproduction with all
tones retained.

Brightness, Contrast,
Gamma, Blur

RGB True Color image
reproduction

Brightness, Contrast,
Gamma, Blur

* The availability of specific scanning modes will depend on your scanner model.

4.2 Setting Scanning Resolution

Scanning resolution is the number of pixels per inch (dpi) in the end
(scanned) image. An image with a high resolution will contain more
and thereby smaller pixels than an image with equal dimensions with a
lower resolution. High resolution images will therefore normally display
more detail and wider color ranges than low resolutions. However,
high resolutions produce larger files with the usual  setbacks in relation
to disk space, load time, etc.
Your selection of resolution will therefore depend mainly on how you
intend to display the image. For offset printing, high resolutions work
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best while for screen and web display, lower resolutions will suffice.
Normally, 300 dpi and above are considered high resolutions. High
resolutions can also be necessary if small details (like in maps) must
be displayed clearly. Often, your printing device documentation will
contain recommendations about scanning resolutions.
The image resolution should be determined before scanning i.e.,
before your original is digitized and the image transformed to pixel
data. Using Photoshop to increase resolution of an image scanned at
low resolutions will normally not improve the image’s quality.

Click on the Resolution list arrow  to reach the list of available
resolution settings. The Wide Format Scanning plug-in offers two
methods for setting resolution – Standard and Custom.

Standard resolutions are round value settings from 50 dpi and up to
the highest resolution supported by your scanner model. The
application will detect your scanner model’s capabilities and only valid
resolutions will be listed. See the technical specifications that came
with your Wide Format Scanner for information on its maximum
resolution capabilities.

Fig. 4-5: Setting the Scan Resolution
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Custom Resolutions – Sometimes you will need to set the resolution
to a specific value in order to match your image with a specific display
device, printer or software application. Or, you may be working with
another image already loaded in Photoshop and wish to match the
resolution of the new image with that of the existing one. If the
resolution you need is not among the standard resolutions then
perform the following steps:
⇒ Click the User Defined option at the bottom of the resolution list.
⇒ A new dialog with a single edit field appears in which you can write

a specific resolution. Only whole numbered resolutions within the
range of 50 and the scanner’s maximum resolution are valid.

⇒ Your new resolution is called “User Defined” in the resolution field
and its value is displayed directly to the left as shown below.

Your Adobe Photoshop manual also gives pointers on determining
image/ scanning resolutions.

Custom resolution value

Fig. 4-6: User Defined Resolution
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4.3 Setting the Original’s Paper Size

In order to perform effective and high quality scanning, the scanner
needs to know the size of your original. This size is called the Paper
Size and it directly defines the “scan field”, which is the area on the
image that the scanner will capture. One could of course choose to let
the scanner digitize everything within it’s maximum width, always
capturing data over the original’s edges, and then crop away the part
you don’t need. But with this method you would at best produce a lot of
unnecessary and unusable data and at worse disturb effective
thresholding and adaptive processing.
Sometimes, you will want to scan only a portion of the whole original.
This can be performed by setting a Paper Size that best fits that
portion you wish scanned and then repositioning the scan field through
Offsets.

4.3.1 About Paper units
Before selecting a paper size, select the measurement unit (Paper
Units) that best fits your purpose. Paper sizes can be entered and
displayed in : Inches, centimeters or Scanner Units. Scanner Units are
marked above the scanner’s insertion slot, so you can make size
measurements directly off the scanner. Your choice of Paper Unit will
be reflected in the Paper Attributes (display only) option group just
under the Paper Units group.
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4.3.2 Paper Attributes
The Paper Attributes value group is a display-only area that informs
you of the current Paper Size dimensions and offsets. Whether using
standard or custom sizes, paper dimensions are displayed in the
measurement units selected in the Paper Units option group.

4.3.3 Setting Standard Sizes
The available standard sizes will cover most of your needs.  Click on
the drop box arrow to view the available predefined standard sizes.
Portrait and Landscape positioning is indicated by the letters “P” and
“L” attached by hyphens to each standard size, for example, A4-P,
Letter-L, etc. The Paper Size’s actual dimensions in inches,
centimeters or scanner units is displayed to the right in the Paper
Attributes group.

Standard Size List          Paper Units           Dimensions & Offsets

Fig. 4-7: Setting a standard Paper Size
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4.3.4 Setting Custom Sizes
Sometimes you will have an original that does not fit with any standard
size or you may wish to crop an original to special dimensions in a
specific image area. You can do both of these through the “User
Defined” option which is selectable at the bottom of the Paper Size List
as shown in Figure 4-6. Here’s how you set a custom size.
⇒ Click on the down arrow in the Paper Size field.
⇒ Select User Defined at the bottom of the size list.
⇒ Enter Paper Size dimension values in the new dialog.
⇒ Enter your Offset values for scan area repositioning or leave them

at 0,0 for normal top left corner positioning. (Details follow below)
⇒ Select OK. Your custom Paper Size (named simply “User

Defined”) becomes the current Paper Size.

The User Defined paper size retains its settings until they are
changed. If you need a new custom Paper Size, repeat the process
above and overwrite the previous values.

Custom Size Setting                  Paper Units                    Dimensions & Offsets

Fig. 4-8: Setting a custom Paper Size
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Move the scan area with offsets (X,Y)

The scanner’s capture area is the area picked up by the scanner’s
cameras and its size is defined by the Paper Size. Normally and per
default, the scanner’s capture area is positioned over the original’s top
left corner.
The X and Y Offsets in the Paper Size dialog, allow you to move the
position of the scan capture area, which means that you can point out
any specific area on the original for scanning. The X and Y values you
enter are like coordinates on a map and the scanning start-point will
be shifted from the original’s top left corner to the position indicated.
Scanning itself will then cover the area specified in the dimensions
fields. This could be a standard size or a custom size. For example,
you might need to capture a logo imprinted somewhere in the middle
of a large poster :

Example : Capture the Logo on a large Poster

⇒ Select the User Defined paper size option from the list of paper
sizes.

⇒ Set the paper size to 5” x 5” or any size slightly bigger than the
logo. This is the size of the scanner’s capture area.

⇒ Use a ruler to measure the logo’s position, using the measurement
units selected in the Paper Units area. You measure from the 0,0
point which is at the original’s top left corner.

⇒ Calculate and enter your offset coordinates so that your scanner’s
capture area (Paper Size) covers the logo. The coordinates you
enter will indicate the position of the scan capture area’s top left
corner.

The above procedure is illustrated in Figure 4-9. The scan capture
area is normally positioned in the top left corner of the original with
offsets at X = 0 and Y = 0. The scan capture area dimensions (Paper
Size) are set to 5” x 5”. The offsets are then set to 8,3” in the User
Defined Paper Size dialog. This moves the effective scan capture area
8” to the right and 3” down in relation to the original’s top left corner.
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 Remember :
• The offset coordinates use the measurement units specified in the

Paper Units area (inches, cm or scanner units.)
• Control your Paper Load setting with the original’s position in the

insertion slot. The Paper Load option will be described in the next
section.

• The X and Y offsets should be set to zero for normal scanning of
whole originals, i.e. with Paper Size dimensions that match the
original’s size.

Fig. 4-9: Placing a Scan Window with Paper Size Offsets

Scan capture area
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4.4 Setting the paper feeding parameter

The Paper Load setting is found at the bottom right corner. Here you
determine if you prefer center loading or loading from the scanner’s
edge. Center loading works best with most originals and is strongly
recommended when scanning thick originals such as cardboard,
foamboard etc. Side loading is convenient when using Scanner Units
for size and offset settings because of the left aligned Scanner Units
Ruler imprinted just above the scanner’s insertion slot.
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5. Trouble Shooting – Common Problems

No Scanner found   - The Wide Format Scanning plug-in dialog tells
you that no scanner is detected or known. This is likely because the
scanner was not turned on and ready when you booted your computer.
The scanner must be turned ON prier to booting for the SCSI
connection to take effect. If this is not the case, see the next problem.

Scanner ON still no scanner found – If the scanner was ON during
booting and you still get the message that no scanner was
found/detected, then try to close and restart Adobe Photoshop. If you
have just installed the plug-in, Photoshop needs to detect it’s existence
in the plug-in folder when it starts up.

Blank (white) image created after scanning - Check the Paper Load
(Center/Side) setting. If your original was not placed according to this
setting, for example, you inserted from the center but your setting is on
“Side Load”, then the scanner will scan and capture the white
background plate. Make sure your Paper Load setting complies with
your original’s actual insertion position.
If the Paper Load setting is correct then you may have “exaggerated”
your Threshold or Adaptive Level settings, rendering them much too
extreme for the image being scanned.

Modes described in this manual not in Mode list – If you are
looking for a scanning Mode described in this manual and it does not
appear as an option in the Mode List, then it is probably not supported
by your scanner model. See the documentation that came with your
scanner for specifications on available scanning modes and features.

Part of the scanned image is cropped out  – Check the Paper Size
setting. The scanner only captures the size defined by the Paper Size
Width and Height settings.

Large white frame around the scanned image – Check the Paper
Size setting. The scanner captures the whole size defined by the
Paper Size Width and Height settings. If these setting extend the
capture area over the originals dimensions, then the scanner picks up
the white background plate.
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Can’t set/find the desired high resolution – If you are looking for a
high scanning Resolution and it does not appear as an option in the
Resolution List, then it is probably not supported by your scanner
model. The highest resolution you can set will be the highest resolution
in the list and the User Defined option will only accept values up to this
maximium resolution for the scanner. See the documentation that
came with your scanner for specifications on its maximum scanning
resolution.
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Slow and jumpy scanning - The more available RAM in Photoshop,
the smoother the Scanning Plug-in will process data and run. If the
progress of the original through the scanner seems slow and in jerky
movements the problme could be that Photoshop does not have
optimal 'memory cash' size. Follow the instructions below to optimize
your system:
• See Help > Help Contents....
• Under Index, type Memory and go to the bottom of the help page
• Click on: ... Increase the application memory size. The help

text that appears (on Photoshop for Macintosh versions) is copied
below:

1) Quit Adobe Photoshop if it is running.
2) Start all applications - except Photoshop - that you must use
simultaneously with Adobe Photoshop. Keep in mind however, that
running other applications with Photoshop uses RAM that could be
allocated to Photoshop.
3) Return to the 'Finder'. Choose 'About this Computer' from the Apple
Menu.
4) Note the 'Largest Unused Block' value (You will need this value in
step 6). This value shows the amount of memory currently available.
5) In the 'Finder', select the 'Adobe Photoshop Program Icon' (Not the
folder or the alias icon). And choose File > Get Info.
6) In the Adobe Photoshop Info Window, set the Preferred Size option
to no more than 90% of the 'Largest Unused Block value' you noted in
step 4.
7) Close the Adobe Photoshop Info Window.

In tests the Preferred Size was increased from 22Mbyte to 102 Mbyte.
Scanning of a picture (A2-L 300DPI 24-bit color) went from 7 min to 47
seconds, and the scanning became smooth. Less RAM will also work
fine, but the more RAM Photoshop has available, the faster the
scanning will be preformed.

Not enough room on disk - Photoshop uses temporary space on the
hard disk to store scanned pictures. If the picture size is too large to be
saved on the hard disk, scanning is not performed, and a message
appears" No scanning performed, Scratch Disk probably too small". If
you have more than one hard disk the all should be in use. To control
this, choose menu File: Preferences: Plug-Ins and Scratch Disks...
Note that Photoshop uses about 25% more than the theoretical size of
the picture, when temporarily saving the picture on the hard disk.
Example: An original with Paper Size = A0-P (33.1 Inch * 46.8 Inch)
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scanned at 300 DPI in RGB Color (3 byte per pixel) mode will have a
theoretical size of 33.1*300 * 46.8*300 * 3 = 400 Mbyte.  Despite this,
Photoshop would use  500 Mbyte for storing such a scanned picture.
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6. Appendix A: Glossary (Scanning Terms)
AdaptiveThresholding

Advanced 2-D Adaptive Thresholding estimates the background gray level in a
window area around each pixel. The difference between the actual pixel value and
the background is then compared to the adaptive settings to determine if a pixel is
thresholded as a black or a white pixel.

Additive Colors
The additive primary colors are red, green and blue. These additive primaries
represent the three main components of white light. Used individually or together,
these three colors of light can be mixed to create nearly all colors. When these
three primary colors are mixed in equal parts they produce white. Additive color is
used in scanners and computer displays.

Bitmapped Image
A bitmapped image is a computer file representing a line-art image that was
scanned with a scanner. Refers to the pattern (map) of bits that are either black or
white.

Blueprint
A process of photographic printing used mainly for copying architectural and
mechanical drawings;  produces blue lines on a white/bluish background.

Blur
The averaging of pixel elements.

Brightness Adjustment
An adjustment on a scanner that allows the user to compensate for a light or dark
original.

Calibration
Adjusting equipment so that it performs in accordance with an established
standard, e.g., scanner calibration, minimizing color deviation between scanned
ANSI IT8 reference color patches and the known color reference values.

CCD
Charge Coupled Device, CCD is the image sensor in the scanner that converts
light to voltages. These voltages are converted by the scanner into the image.

CMYK
The subtractive printing colors. Cyan, Magenta, Yellow, Black.

Color
Electromagnetic energy that exists in the form of wavelengths creates the
perception of color. There is a huge difference between the visible spectrum we
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can see with our eyes and the colors which can be reproduced on a computer
screen and then printed on a color printer. The total number of colors that a device
can produce is called its color gamut. The visible spectrum is larger than the color
gamut of a color monitor, which in turn is larger than that which can be reproduced
by a color printer. No system can produce all the colors visible to the human eye.

Color bit depth
The simplest pixel has two options: black or white. (A pixel with two choices is
known as a 1-bit image, or two raised to the power of one). Adding more bit
information increases the number of color options. The number of potential color
options for a pixel is called color bit depth. For example a 4-bit pixel would have 16
color options, and an 8-bit pixel would have 256 color options, while a 24-bit pixel
would have 16,777,216 color options.

Color Cast
An image is said to have a color cast if its colors are not true. A color cast will
usually be described by stating the particular color predominant in the image, e.g.,
the grass appears to have a red color cast.

Color Correction
Correcting for, and eliminating an unwanted color cast.

Color Management System
Color Management System (CMS) software increases the accuracy of color
interchange between scanners, displays and printers based on profiles for each
device. The CMS is a layer of software resident on the computer that negotiates
color reproduction between the application and color devices. The CMS performs
the color transformations necessary to exchange accurate color  between diverse
devices. The Color manager needs access to characterization data for the device.
The format and content of such device profiles is standardized by the International
Color Consortium (ICC.)

Color Separation
Converting an RGB color image into CMYK color image. Color separation is a
technical function during which critical settings such as GCR, black ink limit and
total ink limit are applied to the image.

Color Space
A color space is a particular language used to describe color. Examples of color
spaces are: RGB, CMYK, HSV, CIE LAB.

Compressing
Reducing file sizes of images by encoding the data (see also Run Length
Encoding and CCITT Group 3 and 4).

Contrast
The range between light and dark in an image. Proper contrast is important for an
image to appear realistic.

Density
The light stopping ability of a film. Density is inversely proportional to the amount
of light reflected or transmitted by an image.
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Density units
Photographers and printers measure transmission in base-10 logarithmic density
units, where transmission of unity corresponds to a density of 0, transmission of
0.1 corresponds to a density of 1, transmission of 0.01 corresponds to a density of
2, and so on

Device Dependent Color Space
For example RGB. A device dependent color space, e.g., the same scan file will
appear different when viewed on different computer displays.

Device Independent Color Space
For example CIE LAB. A device independent color space is one in which color
values are absolute, e.g., defined by CIE standard. CIE LAB is the central color
space in color management systems (CMS) and is used to translate between
different device dependent color spaces such as scanner RGB and display RGB.

Device Profile
A file used as part of a Color Management System (CMS). A device profile
contains information about the characteristics of a scanner, computer display or
printer. The format for device profiles (Win95, Colorsync. etc.) is standardized by
ICC (International Color Consortium).

Display
Also called Graphic display or Monitor. The computer screen attached to your
computer, or to the portion of a drawing image, menu, etc., shown on the  screen.

Dithering
A printing or display device may have only a small number of  grayscale or color
values for each device pixel. However, if the viewer is sufficiently distant from the
printed page or display, the value of neighboring pixels can be set so that the
viewer's eye integrates several pixels to achieve an apparent improvement in the
number of levels or colors that can be reproduced.

DPI
Dots Per Inch, equivalent to Pixels Per Inch. An expression of resolution of a
scanned image.

DSP
Digital Signal Processor, does image enhancement in real-time while scanning.

Dynamic Range
A measurement of scanner quality; the density difference between highlights and
shadows.

Equalizing
Distributing all color or tone equally along a density range.

File
Image, text or program information stored on a computer disk, with a file name for
retrieval (an extension to the name is often added to distinguish between different
types of files).

Folder
An organizational aid on a hard disk. Like office folders, it allows a user to group
related files together.
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Foreground
Foreground when scanning raster data (black and white, or monochrome data)
refers to the pixels that represent data of interest (background refers to everything
else). Typically, lines and shapes are represented by black pixels (foreground) and
empty space is represented by white pixels (background).
When scanning grayscale data, background means the gray level of a region of
pixels that surrounds some desired foreground data.

Gamma Adjustment
An adjustment that makes the tone distribution lighter or darker in an image.

Gamut
The color range scanable, printable or displayable by a device; e.g., if some of the
displayable colors are outside of the gamut of the printer they cannot be printed.

Gamut Transformation
Color Management System function, where out-of-gamut colors are converted to
colors within the gamut of the targeted device, e.g., a printer.

GCR
Gray component replacement. A color separation setting used on color
photographs where cyan, magenta and yellow inks are replaced by black ink (in a
balance that would yield a gray value). The advantages are a reduction in overall
ink usage and some increase in image detail.

Gigabyte
Computer storage equal to 1024 megabytes.

Grayscale
A term for a black and white photographic image or a scanner setting. Refers to
the range of 256 gray tones that make up the image.

Gray Balance Adjustment
A color correction adjustment to insure that gray elements within a scanned image
appear as a neutral gray. It is generally considered proper technique to adjust the
image so that neutral gray elements appear neutral gray. If this is done, it will
usually be true that other elements within the image will also have true color
reproduction.

Halftoning
The processes of offset printing and laser printing are intrinsically bilevel.
However, these devices can reproduce a range of tone levels by halftoning; e.g.,
an array of widely spaced dots produces the perception of light gray, and an array
of tightly spaced dots produces dark gray. Halftone dots are usually placed in a
regular grid. In color printing it is conventional to use cyan, magenta, yellow and
black grids that have exactly the same dot pitch but different carefully-chosen
screen angles.

Histogram
A bar graph representing the statistical distribution of Graytones or colors in an
image. Each column represents the number of pixels at that gray level or color.

HLS
A color space with the three variables of Hue, Lightness, Saturation. See HSV.
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HSV
A color space with the three variables of Hue, Saturation, Value. Hue means color
(as in the color wheel.) Saturation is an indication relating to the richness or
vibrancy of the color. Value is a term best related to the intensity of light
illuminating the object.

Hue
A measurement of color that can be related by pointing towards a certain color on
the color wheel. Hue indicates the relative redness, blueness, greenness,
yellowness, etc., of a color.

ICC
The International Color Consortium (ICC) was formed to address the need for a
common color framework. The ICC has developed a standard device profile that
contains information about how various devices render color. This concept is
supported by Apple (Colorsync), Microsoft for Windows 95, Sun for Solaris, and by
Silicon Graphics for Irix.

ICS
Integrated Component Scanner, integrates copying function into an existing
plotting environment.

Ink-Jet Printer
Inkjet printers transfer color to a page by squirting cyan, magenta, yellow and
black liquid ink onto the page. The ink dries on the paper through evaporation.

Interpolation
Using the interpolation method of resampling generates values for points in
between the actual pixels by looking at the surrounding colors or intensities. In a
scanner resolution is increased beyond the actual number of CCD cells. As each
line of pixel data arrives from the cameras, new interpolated pixels are added
between original pixels. The added pixels enhance line edge definition.

JPEG Compression
Joint Photographic Experts Group Compression. A method to save storage space
by compressing files. JPEG achieves a high degree of compression by discarding
non-important picture detail.

Kilobyte
Computer storage equal to 1024 bytes of computer information.

Laser/LED Printer
Laser/LED printers transfer toner to a page by discharging an Electro-statically
charged drum using the information modulated light from a laser or LED (Light
Emitting Diodes) array. Toner then attaches to the remaining charged areas of the
drum, and is subsequently transferred to the paper

Lossless Compression
File compression and subsequent de-compression without any loss of data.

Lossy Compression
File compression that will compress data to a high degree. When subsequently
un-compressed, data will have been lost.
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LZW
Method of lossless compression used with many file formats; developed by
Lempel, Zev and Welch.

Megabyte
Computer storage equal to 1024 kilobytes.

Monochrome
An image composed of a single color.

Neutral
An area of no color; white, gray or black.

Noise
A term used to describe the occurrence of pixels that contain random colors
within an image.

Palette
The set of colors available for an image.

Pixels
The word pixel is a combination of the two words picture and element. It is the
smallest building block within a scanned line-art or photographic image. A pixel is
the small square picture element that is filled with a color, black or white.
The value of a pixel depends on the luminance of the area, and is either a single
bit for a black and white image, or multi-bit for a color or gray-tone image.
Pixels come in various sizes and their size is expressed in terms of resolution.
Resolution is measured in pixels per inch (ppi) or the equivalent dots per inch
(DPI.)

Plotter
A physical device that receives information of a digital image and reproduces it on
paper (see also Inkjet and Laser/LED plotter).

Printable Color
A color that falls within the gamut of a particular output device.
A printable color will output as expected, compared to a color that falls outside the
gamut which will print as an unexpectedly different shade. See also Gamut.

Printer
A physical device that receive information of a digital image and reproduces it on
paper (see also Inkjet and Laser/LED printer).

PROM
Programmable Read Only Memory.

RAM
Random Access Memory. RAM is a computer resource; having more RAM in a
computer makes it faster and more capable.

Raster File
Also called Raster Image or Bitmapped Image. A picture composed of individual
dots (picture elements, pixels) the way a scanner perceives it. The rows in a high-
resolution raster file typically contain 200 or 300 dots per horizontal inch of the
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original drawing, and there are typically 200 or 300 rows per vertical inch. As each
of these dots is defined by location, and by whether it is on or off, raster images
generally result in large data files.

Resolution
Defines the level of detail that can be captured or shown by a scanner, display, or
output device. For scanners, the resolution is defined by the number of dots
(pixels) per inch (DPI) that can be captured horizontally and vertically, e.g. 300
DPI equals 90,000 pixels per square inch.

Resolution of a Scanner
Expressed as DPI (dots per inch) or the equivalent ppi (pixels per inch). The
higher the resolution of a scanner, the smoother the scanned images.

RGB
Red, Green, Blue. These additive primary colors are the basic elements of white
light. By mixing them on a computer monitor or in a scanned image file, other
colors can be created. For instance, Red and Green produces Yellow, and equal
amounts of all three produce gray.

RIP
Raster Image Processor. A RIP is a special software that converts scanned
images into a color dithered (halftone) image that can be output directly. An image
must be 'ripped’ before it can be output on a CMYK device, e.g., an inkjet printer.

Runlength Encoding
A method of compressing raster or bitmap data by representing "runs" of white or
black dots along a scanned line as the number of dots in each run. Many
variations of this scheme exist, with varying compression efficiency. Typically,
runlength compression formats yield a file 20-25% the size of an uncompressed
file.

Saturation
Saturation is one attribute of color in the color space called HSV (Hue Saturation,
Value). Saturation is a characteristic indicating the vibrancy or intensity of a hue. A
color with high saturation will appear more intense than the same color with less.

Scanning
The process of running a hardcopy original through an optical scanner. The
scanner produces a digital image (raster image) of the hardcopy drawing, which is
then stored in RAM or on a disk.

SCSI
Small Computer System Interface. Specification of interface to computer
equipment like disks, printers, scanners etc.

Shadow Detail
The amount of detail contained in the dark parts of an image. It is desirable to
maintain shadow detail, but there is a risk of decreasing overall contrast if one
lightens the shadow too much in an attempt to expose additional detail. If an
image is scanned without shadow detail, it will be impossible to regain detail using
an image editing program.
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Sharpness
An attribute of a scanned image and also an attribute of scanner quality.

Stitching
In large format multiple CCD camera scanners, electronic stitching adjusts for
overlap in the field of view of adjacent cameras. Automatic stitching at start of
scan ensures that each camera captures the correct number of pixels
independently of mechanical and thermal changes.

Subtractive Colors
The subtractive primary colors: cyan, magenta, yellow. As ink applied to a piece of
paper by a printer, these colors absorb light and alter the colors seen by looking at
the printed paper. Cyan ink absorbs the red third of the spectrum, magenta ink
absorbs the green third, and yellow ink absorbs the blue third. This should
theoretically cause the viewer to see a black color, but due to unavoidable
impurities in the inks, there is still light reflected and the viewer sees a muddy
brown. The absence of CMY pigments results in white.

TIFF
Tagged Image File Format. One of the most common graphic file formats for line-
art and photographic images.

Tonal Distribution
Tonal Distribution describes the distribution of various bright or dark tones within
an image. During the scanning or image editing stage, tones can be redistributed,
lightening a dark image or darkening a light one.

Tone
Any color or neutral that is denser than white.

Tone Compression
A term used in scanning and image editing that refers to compressing the broad
range of tones and colors in an image down to the narrower range available on a
printer.

Tone Curves
The shape of the tone transfer curves can be adjusted by the user to alter color or
tone correction. The lower left end of the curve typically represents the dark
portions of a picture and an upward bend will typically lighten the shadows. Similar
capabilities exist by working with the middle or highlight parts of the curve. In this
way it is possible to alter only certain tonal ranges of an image without making un-
wanted changes to other parts of the image.

True color
True color systems provide eight bits for each of the three components (red, green
and blue). Therefore true color is often referred to as 24-bit color.

UCR
Under Color Removal. A color separation setting used on color photographs where
cyan, magenta and yellow inks are removed from dark, neutral areas and
substituted by black ink. The advantages are a reduction in overall ink usage. See
also GCR.

Vector Drawing
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Also called Vector File. Consists of mathematically defined elements, such as
"Line from A to B", "Circle with center and radius", etc. CAD systems use vector
drawings because of their accuracy, relatively low memory requirement and data-
file sizes compared to raster images.

Vectorization
Also called raster-to-vector conversion (RTV). The process of automatically
converting a raster (bit-mapped) image into a vector (CAD) drawing.

Viewing Conditions
Different light sources affect the colors that you see. For instance, a color viewed
under fluorescent light will look radically different when viewed under incandescent
light. Fluorescent light adds green to colors while incandescent light adds red. For
this reason the printing industry developed a standard viewing condition known as
the D50 (5000 Kelvin) light source in addition to a neutral gray background
surround. This light source replicates daylight with equal parts of red, green, and
blue.

XYZ
The CIE system is based on the description of color as a brightness (luminance)
component Y (as described above), and two additional components X and Z. The
spectral weighting curves of X and Z have been standardized by the CIE, based
on statistics from experiments involving human observers. XYZ tri-stimulus values
can describe any color.

Zoom
Changing the size of the viewing area, to examine a larger or smaller area in
greater detail.
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7. Appendix  B: Program License Agreement
You should carefully read the following terms and conditions before opening the
diskette package. Opening the diskette package indicates your acceptance of the terms
and conditions. If you do not agree with them you should promptly return the package
unopened, and your money will be refunded.
Contex provides this program and licenses its use. You assume responsibility for the
selection of the program to achieve your intended results, and for the installation, use
and results obtained from the program.

License
1. You may use the program on a single machine.
2. You may modify the program and/or merge it into another program for your use on

the single machine.
3. You may copy the program into any machine readable or printed form for backup

or modification purposes in support of your use of the program on the single
machine.

4. You may not use, copy, modify or transfer the program, or any copy, modification
or merged portion, in whole or in part, to another party, except as expressly
provided for in this license. If you do so you terminate your license.

Term
The license is effective until terminated. You may terminate it at any time by
de¬stroying the program together with all copies. The license will also terminate upon
conditions set forth elsewhere in this Agreement or if you fail to comply with any term or
condition of the Agreement. You agree upon such termination to destroy the program
together with all copies, modifications and merged portions in any form.

Limited Warranty
This program is provided as is, without warranty of any kind, either stated or implied,
including but not limited to the implied warranties of merchantability and fitness for a
particular purpose. The entire risk as to the quality and performance of the program is
with you. Should the program or hardware provided with the program prove defec¬tive,
you (and not Contex or an authorized dealer) assume the entire cost of all necessary
servicing, repair or correction.
Some states do not allow the exclusion of implied warranties, so the above exclusion
may not apply to you. This warranty gives you specific legal rights; you may also have
other rights which vary from state to state. Contex does not warrant that the functions
or the operation of the program will be uninterrupted or error free.
However, Contex warrants the diskette on which the program is furnished to be free
from defects in materials and work¬manship under normal use for a period of one (1)
year from the date of delivery to you, as evidenced by a copy of your receipt.

Limitations of Remedies
Contex's entire liability and your exclusive remedy shall be:

The replacement of any diskette not meeting the Contex "Limited Warranty" and which
is returned to Contex or an authorized Contex dealer with a copy of your receipt, or
If Contex or the dealer is unable to deliver a replacement diskette which is free of
defects in materials or workmanship, you may terminate this Agreement by returning
the program and your money will be refunded.
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In no event will Contex be liable to you for any damages including any lost profits, lost
savings, or other incidental or consequential damages arising out of the use or inability
to use such program, even if Contex or an authorized Contex dealer has been advised
of the possiblity of such damages, or for any claim by any other party. Some states do
not allow the limitation or exclusion of liability for incidental or concequen¬tial damages,
so the above limitation or exclusion may not apply to you.

General
You may not sublicense, assign or transfer the license of the program except as
expressly provided in this Agreement. Any attempt otherwise to sublicense, assign or
transfer any of the rights, duties or obligations hereunder is void.
This Agreement will be governed by the laws of Denmark. Should you have any
questions concerning this Agreement, you may contact Contex.
You acknowledge that you have read this Agreement, understand it, and agree to be
bound by its terms and conditions. You further agree that it is the complete and
exclusive statement of the agreement, oral or written and any other communications
between us relating to the subject matter of this Agreement.

CONTEX
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